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InDesign CS6

8 Nome:

Sobre o curso Adobe InDesign CS6

Adobe InDesign é um software da Adobe Systems desenvolvido
para diagramacao e organizacao de paginas, criado para substituir o
Adobe PageMaker, apresentando uma variedade de aprimoramentos, El]
resultando em mais produtividade. O programa cria documentos em
formato proéprio, editavel, que posteriormente pode ser exportado Carga horaria
para PDF ou outros formatos especificos de impressdo. Hoje junto @ 18 horas
S

Quantidade de Aulas
12 aulas

com os programas Photoshop e lllustrator, também da Adobe,
formam as principais ferramentas de trabalho utilizadas por agéncias
de publicidade, editoras de jornais e revistas, industrias de
embalagens, departamentos de marketing e afins.

Programas Utilizados
InDesign CSé6

O que aprender com este curso?

Aprenderemos a criar paginas com estilo de revista, com textos,
imagens, formatacdes simples e aplicacoes de efeitos, dividir textos
em colunas, aplicar efeito capitular, recurso onde a primeira letra do
paragrafo fica maior, e até mesmo gerar o arquivo em formato PDF,
entre outros recuros.
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Adobe InDesign CS6

1. Apresentacao e area de Trabalho 1

Aula

aInDesign foi criado com o intuito de
facilitar a diagramacao de paginas. Ele foi

desenvolvido pela Adobe Systems para substituir
o Page Maker. A fase em que o InDesign é
utilizado na producao de uma pagina é conhecida
como Pré-impressao, ou no inglés pre-press.

Atualmente, junto com o Adobe Photoshop,
esta é a ferramenta ideal para trabalhar com
diagramacao de paginas.

O profissional que pretende trabalhar nesta
area, e ser o melhor, deve pelo menos saber
trabalhar com os dois softwares razoavelmente.

Area de trabalho do InDesign

Antes de comecar a trabalhar com o
InDesign, é necessario conhecer um pouco sobre
sua area de trabalho.

Vejamos a seguir um pouco sobre os
componentes desta area.
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1. Este é o controle de zoom. Quanto maior a
porcentagem, mais proxima serd a visao da
pagina.

2. Estes sdo os menus. Através deles temos
acesso a praticamente todas as funcbes do
programa.

3. Esta é a barra de controle. Esta é uma
parte muito importante do InDesign, visto que
muitas das configuracoes serao feitas através
dela. Dependendo do objeto selecionado, as
opcoes exibidas aqui nesta barra poderao variar.

RN L EE T R e |

Esta, mostrada acima, é a barra de
ferramentas principal. Através dela temos acesso

as principais ferramentas de criacdo do InDesign.

Lembre-se sempre: apds utilizar uma
ferramenta de criacado, ative uma ferramenta de
selecdo. Isto fard com que vocé desative a
ferramenta de criacdo e nao fique desenhando
componentes indesejados.

Gap Tint:  100%

Mostradas acima, temos as paletas de
ferramentas. Estas serdao muito Uteis na hora da
formatacao de objetos, como caixas de texto,
formas geométricas e imagens.

A maioria das paletas é ativada pelo menu
Window. Portanto caso vocé nao encontre
alguma, é 14 que deverd procurar.

1.1. Exercicios Passo a Passo

1. Abra o Adobe InDesign CS6. Vamos criar
quatro retangulos com tamanhos e cores
diferentes. Clique duas vezes no icone do
programa na Area de Trabalho.

2. Clique na opcao Document e, em seguida,

cligue OK;
_
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3. Selecione a ferramenta Rectangle;

4. O primeiro serd o menor, na cor azul,
conforme o indicado;

5. O segundo serd um pouco maior que o
anterior, na cor verde, conforme o indicado;

6. O terceiro serd um pouco maior que o
anterior, na cor amarelo, conforme o indicado;

7. O ultimo serd o maior, na cor vermelho,
conforme o indicado;

1.2. Exercicios de Fixacao

1. Abra o Adobe InDesign CSé6 e crie um
novo documento, ative a ferramenta Rectangle e
crie as formas conforme o indicado.
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InDesign CSé6

2. Caixas, Ferramentas de Desenho,
Réguas e Elementos

Adobe InDesign CS6

Aula

2

aInDesign é um programa que trabalha
basicamente com caixas. Isto é, criamos

molduras em uma pagina para depois preenché-
las com conteudo.

Temos trés tipos de caixas especificas para
cada tipo de conteudo, que serao citadas a seguir.
Mas antes, temos algumas propriedades que se
aplicam a todos os tipos de caixas.

Um exemplo de propriedade que se aplica a
todos os tipos de caixas é a insercio de
conteudos externos.

Para inserir conteido em uma caixa (os
contetidos mais comuns sao imagens e arquivos
de texto), primeiramente selecionamos a caixa.
Feito isso acessamos o menu File e clicamos
sobre a opcdo Place.

Outra opcao que se aplica a todos os tipos de
caixa é o ajuste de tamanho entre a caixa e seu
conteudo.

Com a caixa selecionada, acessamos o menu
Object e clicamos sobre a opgao Fitting. Sao
exibidas as seguintes opcoes:

1  Fill Frarne Proportionally Alt+Shift+ Crl+ C
Fit Content Proportionally Alt+Shift+ Ctrl+E

3 Fit Frame to Content A+ Ctrl+C
Fit Content to Frame Alt+ Ctrl+E

3 Center Content Shift+ Ctrl+E

6 Clear Frame Fitting Options

7 Frame Fitting Options...

1. Fill Frame Proportionally - esta opcao
ajusta o tamanho da caixa ao contetido, mas sem
perder suas proporcoes.

2. Fit Content Proportionally - esta opcao
ajusta o tamanho do contelido a caixa, mas sem
perder suas proporcoes.

3. Fit Frame to Content - esta opcao ajusta o
tamanho da caixa ao conteudo.

4. Fit Content to Frame - esta opcao ajusta o
tamanho do contelido ao tamanho da caixa.

5. Center Content - esta opcao centraliza o
conteudo na caixa.

6. Clear Frame Fitting Options - limpa as
opcoes relacionadas a esse assunto.

7. Frame Fitting Options - abre uma caixa de
didlogo com mais opcoes de ajuste.

Agora vejamos mais detalhadamente as
opcoes de cada tipo de caixa:

Caixa de Texto

[T

Podemos transformar qualquer caixa em
uma caixa de texto. Para isso, basta ativar a
ferramenta de texto e clicar sobre a caixa
desejada.

Em uma caixa de texto, temos dois
elementos um tanto quanto importantes:

:Texto - Texto
1 Texto -Texto [

1. Esta é a alca de conexao. Com ela vocé
pode conectar uma caixa de texto a outra.

2. Este sinal de adicdo serve para mostrar
que ha mais texto do que o que estd sendo
exibido. Vocé pode clicar sobre este sinal e
“derramar” o texto em outra caixa.

Caso vocé conecte uma caixa de texto com
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outra, é possivel ver estas conexodes. Para isso
vocé devera acessar o menu View e clicar sobre a
opcao Show Text Treads.

Caixa de Imagem

EX

As caixas de imagem sado caracterizadas
principalmente pelo X em suas diagonais.

Com uma imagem dentro da caixa, s6 sera
possivel redimensionar e ou mover a imagem
utilizando a seta de selecao direta.

Caixa de Poligonos

=X

Esta ferramenta serve para desenhar formas
geométricas que poderdo ser coloridas ou
transformadas em caixas de texto
posteriormente.

Ao clicar e segurar sobre o icone desta
ferramenta, vocé terd acesso a criacdo de
poligonos.

Para ter acesso a maiores configuracoes da
criacao de poligonos, ative a ferramenta e apenas
dé um clique sobre a pagina do InDesign.

Ferramentas de desenho

Ao se trabalhar com o InDesign, serd de
grande importancia saber utilizar as ferramentas
de desenho. Temos trés delas:

Ferramenta Caneta

4]

Esta é uma das ferramentas de desenho
preferidas entre os profissionais de design. Ela
permite que vocé crie pontos de desenho e
depois ajuste sua curvatura utilizando as curvas
de bézier.

Ferramenta Linha

N

Esta ferramenta permite desenhar linhas
retas. Para que as linhas saiam perfeitamente
retas é necessario segurar a tecla Shift.

Ferramenta Lapis

(2]

Esta é a ferramenta mais basica de desenho.
Ela permite criar desenhos de tracado a mao
livre.

Régua

O InDesign possui duas réguas, uma
horizontal e outra vertical. A funcdo destas
réguas é ajudar o usuario a melhor se situar e
posicionar os objetos em uma pagina.

A unidade de medida padrao que o InDesign
utiliza é a paica, porém vocé pode alterar estas
medidas. Para isso devera acessar o menu Edit,
posicionar o cursor do mouse sobre a opcao
Preferences e clicar sobre a opcdo Units &
Increments.

Elementos do InDesign

Para que vocé se torne um bom profissional
é necessario conhecer bem o programa que
utilizara. Conheca um pouco mais sobre a area de
trabalho do InDesign a seguir.

3

2
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1. Esta € a margem da folha. Ela delimita a

area de texto, mas isto ndo quer dizer que vocé 5o
nao possa ultrapassa-la.

2. Esta é a borda de corte, a pagina
propriamente dita.

3. E esta é a pasteboard. Ela serve para
abrigar os elementos que vocé nao utilizard ou
estd utilizando. Lembre-se que os itens nela ndo
serao impressos.

2.1. Exercicios Passo a Passo

1. Abra o InDesign;

2. Crie um novo documento de 200 mm por
200 mm;

3.Crie um retangulo de 100 mm por 30 mm;
4. Atribua uma cor a esse retangulo;

5. Transforme-o em uma caixa de texto,
digite "InDesign CS6" e ative a seta de selecao;

6. Acesse o menu Object e posicione o
cursor do mouse sobre a opcao Fitting;

7. Clique sobre a opcao Fit Frame to
Content;

8. Utilizando a seta de selecao e segurando
as teclas Shift e Ctrl ao mesmo tempo,
redimensione a caixa de texto para que fique
maior;

9. Utilizando as ferramentas de desenho faca
um enfeite ao redor da caixa, conforme o
indicado.

2.2. Exercicios de Fixacao

1. Para a realizar o exercicio, solicite o
arquivo auxiliar com o seu instrutor. Faca a
montagem conforme o indicado.
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Adobe InDesign CS6

3. Paletas Swatches e Stroke 3

Aula

mo InDesign, a aplicacdo de cores nos
objetos ocorre principalmente pela paleta

Swatches. Portanto é importante que vocé se
familiarize bem com ela, pois ainda a vera por
muito tempo.

%‘ @ T Tinit: b oy

B [Regsvation] -
[] [Paper]
[ RS AEX

B c=100 M=0 ¥=0 K=0 &
B c=0M=100¥=0 K=0 B X 5
[] ©=0M=0Y=100 K=0 &
B c=ism=0v=100k=0 3 [E
B c=75 M=5 ¥=100 K=0 &
Bl c=100 M=50 v=10 K=0 B x

1. Esta ferramenta serve para alternar entre
aborda e o preenchimento do objeto.

2. Em caixas de texto, esta ferramenta serve
para alternar entre o objeto e o texto.

3. A propriedade tint serve para
“enfraquecer” ou clarear a cor aplicada ao objeto.

4. Através deste botao temos acesso a opcao
New Color Swatch, que abre uma caixa de
didlogo onde podemos criar uma nova cor.

5. Estas sdo as cores da paleta Swatches.
Clicando sobre uma delas, a mesma sera aplicada
ao objeto em questao.

Como citado anteriormente, clicando sobre
a opcao New Color Swatch, podemos criar uma
nova cor. Esta criacdo da nova cor é feita através
da caixa de didlogo mostrada abaixo:

New Color Swatch l
Swatch Name: C=0 M=44 Y=100 K=10
[7] Hame weith Color Vakie [ cancel
Color Type:  Process - 1 | Add
==

Color Mode:  CMYK - E

o
Hagenta —————yry— 44 LY
Yelow e———— (100 %

BHEK spp— (10 |%

1. Estas duas opcoes permitem alterar o
modo de cor. Lembrando que o modo padrao do
Windows é o RGB.

2. Estes sdo os controles de cor. Devemos
desliza-los para obter novas cores.

3. Nesta caixa podemos prever como ficard a
cor antes mesmo de inseri-la em um objeto.

4. O botdo Add adiciona a cor criada a paleta
Swatches.

Apds adicionar todas as cores desejadas, é
necessario pressionar o botdo OK para fechar a
caixa de didlogo.

Caso nao queira criar uma nova cor, clique
sobre o botao Cancel.

Paleta Stroke

A paleta Stroke serve para aplicar todo tipo
de alteracao a borda dos objetos. Lembrando que
nao é necessario que esteja ativada a opcao
Stroke (borda) na paleta Swatches para que as
alteracoes feitas aqui sejam aplicadas.

Vejamos a seguir as opcoes que a paleta
Stroke nos oferece.
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¢stroke [Golor | =

1 Weight: ipt = C;p:E]E [==
2 4 X Jc"ln:[E i
Align Stmoke: mn 0z

-
-
-
-

Miter Limit:

4 Type:
Start:

End:

5, Gap Color: | [ [Mone]
g Gap Tint:

MNome

Nome

100% b

1. Esta propriedade determina o tamanho ou
largura da linha que compoe a borda dos objetos.

2. Esta opcao serve para limitar o angulo que
é criado pela interseccao de duas linhas. Ou seja,
de um canto.

3. Esta opcao serve para alinhar a borda do
objeto. As opcoes sdo para dentro do objeto, em
cima da linha (meio) e para fora do objeto.

4. A opcao Type determina o tipo da linha
gue fard o contorno do objeto.

5. A opcao Gap Color determina a cor de
fundo da linha que faz o contorno do objeto.

6. A opcao Gap Tint funciona como a opcao
Tint, porém é aplicada apenas a Gap Color.

3.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento;

2. Ative a ferramenta retangulo e desenhe
um retangulo de um lado ao outro da pagina;

3. Na paleta Swatches, crie uma nova cor
utilizando a opcao New Color Swatch;

4. Altere a opcao Color Mode para RGB;

5. Altere a opcao Red para 170, a opcao
Green para 125 e aopcao Blue para 255;

6. Cligue em Add e, em seguida, clique em
Done;

7. Na paleta Stroke, altere a largura da borda

N,

para 10mm. Altere também o tipo da linha para
White Diamond.

8. Ative a ferramenta de texto e converta o
retangulo para uma caixa de texto e digite "Aula
03";

9. Formate o texto como bem desejar;

10. Salve seu documento na Area de
trabalho.

3.2. Exercicios de Fixacao

1. Faca a montagem conforme o indicado.

anotagoes
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e Salvando Arquivo

4. Configurando Pagina, Posicionamento

Aula

4

. omo o InDesign é um software que lida com
a diagramacao de paginas, é necessario que
os desenhos criados nele sejam extremamente
precisos. Paraisso, o InDesign utiliza duas réguas,
uma horizontal e outra vertical. Réguas estas que
utilizam unidades de medida.

A unidade de medida padrao do InDesign é a
Paica (que equivale aproximadamente a
4.23mm).

Podemos alterar estas unidades de medida
acessando o menu Edit>Preferences>Units &
Increments. Fazendo isto sera exibida a seguinte
caixa de diadlogo:

Prelererces - - ie E
— - = = =" = = _ Sl 3
| e’ Units & Bncremants
imetinn
| [ rvem Fler Units
Azopcad Toe - == |
o i - |
e Varbcat  salicratan -
oty & Burpimaes |
|
L dither Unis !
I Sxoke; Fonts - i
tetm I
vl PortPia San I
Sy a
i, Bk Benti/ineh: | PosSorot (72 pha'inch) = L
Aapewwos o Bacu
P, Kiptioand Incremmants t
Erarnar Ky |6, 333 i Baselre Shifts 2 ot I
SafLmadeg: 2 pt gemng/Trading: 20 FLODY e i
W
N
I
(B
|.
K

Lembrando que a opcdo Horizontal vale para
a régua horizontal e a opcao Vertical vale para a
régua vertical.

OBS: caso vocé altere as unidades de medida
do InDesign com um documento em edicao, estas
alteracoes valerao apenas para o documento em
edicao.

Caso vocé altere as unidades de medida sem
nenhum documento aberto, estas alteracoes se
tornardo o padrdo para todos os outros
documentos.

Orientacao da pagina

Na hora da criacdo de um novo documento, é
possivel alterar a orientacdo da pagina. Isto €, a
posicao em que a pagina ficara.

Em portugués temos uma maneira de
nomear as duas posicoes, que sdo Retrato e
Paisagem.

No inglés as palavras utilizadas sao
respectivamente Portrait e Landscape.

Veja abaixo a opcao na caixa de didlogo New
Document que permite alterar a orientacdo da
pagina:

Dogument Preset: [Defauk] - |I]
| Intent: Print - lW|
Humber of Pages: i | Facing Pages
I Start Page #: 1 | Primary Text Frame

Page Ste: Letter T [ More options._ |

Crentation: ['LE =

Width: -£:215,9 mm
Height: | * 279,4 mm

Columns
Humber; 1 Gutter: * 4,233 mm
Margins
Top: = 12,7 mm Inside: £112,7 mm
L Bottom: = 12,7 mm m Dutside: 212,7 mm

Ajustando a sobreposicao de objetos

O InDesign trabalha especificamente com
camadas, ou niveis. Isto é, cada objeto fica em
uma camada. Sendo assim, alguns objetos
poderao ficar sobre os outros, fazendo com que
nao possamos Vé-los.

Para ajustar a sobreposicao dos objetos
acessamos o menu Object e posicionamos o
cursor do mouse sobre a opcao Arrange. Isto fara
com que sejam exibidas as seguintes opcoes:
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Bring to Frant  Shift-+Ctrl+]
Bring Forward Chri+]
Send Backward Chrl+[
Send to Back  Shift+Ctri+[

1. Bring to Front: tras o objeto selecionado
para frente de todos os outros no projeto.

2. Bring Forward: sobe o objeto selecionado
em uma camada no projeto.

3. Send Backward: desce o objeto

selecionado em uma camada no projeto.

4. Send to Back: envia o objeto selecionado
para tras de todos os outros no projeto.

Agrupando Objetos

Para manter a organizacado em um projeto,
podemos agrupar dois ou mais objetos em um soé.
Isto &, utilizando a ferramenta de selecao
parecerd que temos apenas um objeto, pois
movendo um, todos os outros agrupados serao
movidos juntamente.

Para agrupar objetos, primeiramente
devemos selecionar todos os objetos que
gueremos agrupar. Em seguida, acessamos o
menu Object e clicamos sobre a opcao Group.

Para desagrupar objetos agrupados, basta
selecionar o grupo, acessar o menu Object e
clicar sobre a opcao Ungroup.

Fixando Objetos

Apo6s posicionar um objeto corretamente,
podemos fixa-lo, ou tranca-lo, em seu lugar. Isto
serve para que nao possamos mover os objetos
acidentalmente.

Para "trancar" um objeto em sua posicéao,
primeiramente é necessario seleciona-lo. Feito
isso, basta acessar o menu Object e clicar sobre a
opcao Lock Position.

Para "destrancar" um objeto fixado, basta
seleciona-lo, acessar o menu Object e clicar
sobre a opcao Unlock Position.

N,

Salvar documentos

Salvar seu trabalho é uma parte muito
importante do desenvolvimento. Pois mesmo o
InDesign sendo tdo seguro quanto a perda de
documentos, ainda sim vocé pode perder o que
esta criando.

O recomendado é salvar seu documento no
inicio do desenvolvimento utilizando a opcao
Save as, e ao longo do desenvolvimento ir
salvando utilizando a opcao Save.

Pois lembre-se, é melhor prevenir do que
remediar, e vocé ndo ird querer perder seu
trabalho que passou 3 horas fazendo.

|- T

Safvarem: | © Meus Aguives
||
Inizin

Aree de
Trabalhe

2 ir E

Dot de modificagio

MName Tipa

Henhum dem coresponde & pesquiss

Bibliotecas

Este
Computadar

-
Rede T

Unfided-1incd wof [ sdvar |

Inliesig 56 document Carcalar

18 &vemys Save Preview Images with Damumants

4.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento;

2. Altere a orientacdo da pagina para
Paisagem;

3. Acesse o menu Edit>Preferences>Units &
Increments. Altere a unidade das réguas
horizontal e vertical para Centimetros;

4. Com ajuda das réguas, crie um quadrado
de cinco centimetros de altura e cinco de largura;
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5. Altere a cor de sua borda para preto e
altere também a largura da borda para 1mm;

6. Altere a cor de preenchimento deste
guadrado para verde;

7. Utilizando as opcoes Copy e Paste, faca
quatro copias deste quadrado;

8. Dé uma cor diferente para cada um dos
quadrados;

9. Utilizando as opcoes do menu
Object/Arrange, posicione os quadrados
conforme o indicado;

10. Agrupe os objetos;

11. Com o objeto selecionado, acesse o
menu Object e clique sobre a opcao Lock;

12. Salve o documento em sua pasta como
Obijetos.

4.2. Exercicios de Fixacao

1. Faca a montagem conforme o indicado.

anotagdes
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5. Formatacao de Textos

Aula

Adobe InDesign CS6
o criar o layout de wuma pagina,
normalmente precisaremos inserir o texto
que a pagina conterd. Porém, algumas vezes
ainda nao possuiremos este texto. Portanto, o
InDesign oferece um recurso para preencher as
caixas de texto com texto de exemplo, ou texto
falso como também pode ser chamado.

Para preencher uma caixa com texto de
exemplo, primeiramente devemos seleciona-la.
Em seguida acessamos o menu Type e clicamos
sobre a opcao Fill With Placeholder Text.

sendo assim
da pagina

A caixa serd preenchida,
possivel para o desenvolvedor
formata-la da maneira desejada.

Na hora da insercao do texto real, basta
deletar o texto de exemplo de dentro da caixa,
pois as formatacoes nao serao perdidas.

Selecao de texto

Ao se trabalhar com formatacao de texto,
um passo fundamental é sabe selecionar o
mesmo. No InDesign € possivel selecionar
diferentes trechos de texto com diferentes
nameros de cliques.

Veja a seguir uma relacdo com as maneiras
mais faceis e rapidas para que vocé selecione o
texto desejado.

¢ Dois cliques: seleciona somente a palavra.

e Trés cliques: seleciona toda a linha de
texto.

e Quatro cliques: seleciona todo o paragrafo
de texto.

e Cinco cliques: seleciona todo o texto
contido dentro da caixa.

Lembrando que estes cliques podem ser
dados sobre qualquer palavra da linha, paragrafo

N,

ou caixa de texto.
Modos de formatacao

Por ser um software que trabalha com
diagramacdo de paginas, o InDesign possui
diversas opcoes de formatacao de texto. Vejamos
a seguir as opcoes de formatacdo de texto
contidas na barra de controle:

& | s 135 2o
Eil'g o 148 W

- nd - T TA e
o e BT TIOF1L  Gwen e

[k J== S ek

1. Estas opcoes alternam entre o modo de
formatacao de pardgrafo e de caractere. As
ferramentas sdo as mesmas, apenas mudam de

posicao.

2. Neste campo podemos alterar a fonte do
texto selecionado.

3. Este campo permite alterar o estilo do
texto selecionado. Dentre os estilos, temos:
Negrito (Bold), Italico (Italic) e Negrito Italico.
Lembrando que alguns tipos de fontes ndo
possuem todos os estilos.

4. Neste campo alteramos o tamanho da
fonte.

5. Este é o campo onde podemos alterar o
espacamento entre linhas do texto.

6. A opcao All Caps faz com que todos os
caracteres selecionados se tornem maitsculos.

7. A opcao Superescrito faz com que o texto
selecionado fique escrito acima da linha normal
de texto.

8. Aplica o estilo Sublinhado ao texto
selecionado.

9. A opcao Small Caps faz com que apenas a
primeira letra do texto selecionado seja
maiuscula.
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10. A opcao Sobrescrito faz com que o texto
selecionado fique escrito abaixo da linha normal
de texto.

11. Aplica o estilo Tachado ao texto.

12. Neste campo temos as opcOes de
alinhamento do texto dentro da caixa.

13. Estas duas opcoes permitem inserir
espacamento entre a margem esquerda e direita
da caixa de texto.

14. Estas duas opcdes permitem inserir
espacamento antes da primeira linha e depois da
ultima linha de texto dentro da caixa selecionada.

Criando uma letra Capitular

Criar uma letra capitular no InDesign é um
processo muito simples. Primeiramente devemos
selecionar aletra que se tornara capitular.

Em seguida, acessamos o menu Window,
Type & Tables, escolhemos a opcdo Paragraph.

g
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1. A opcdo em destaque define quantas
linhas a letra capitular ird ocupar, no exemplo vai
ser ocupado trés linhas.

2. Ao lado podemos definir o nimero de
letras que se tornardo capitulares, no exemplo
apenas uma letra sera capitular.

meiramente devemos seleciond-la. Para preencher
uma caixa com texto de exemplo, primeiramente
devemos seleciona-la. Para preencher uma caixa com
texto de exemplo, primeiramente devemos seleciona-la

‘ P ara preencher uma caixa com texto de exemplo, pri-
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5.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento.

2. Crie trés caixas de texto conforme o
indicado:

3. Na caixa de cima digite: Linguas - O Latim.
Formate este texto com a fonte Verdana,
tamanho 36pt e alinhamento Centralizado;

4. Clique no menu File, Place (acesse a pasta
Arquivos auxiliares, aula 5, abra o documento
Latim), abra-o. Clique dentro da primeira caixa de
texto;

5. Clique no sinal de "+" e, em seguida, clique
dentro da segunda caixa de texto;

6. Formate o texto alinhamento Justificado;

7. Salve o documento em sua pasta como
"exercicio-aula5".

5.2. Exercicios de Fixacao

1. Abra o InDesign CS6 e crie um novo
documento;

2. Crie dois retangulos, um abaixo do outro,
de um lado ao outro da folha, dentro das
margens, se preferir crie o primeiro e copie e cole
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o segundo;

3. Crie trés retangulos com tamanhos
semelhantes, um ao lado do outro;

4. Cliqgue na ferramenta de texto e clique
dentro do primeiro retangulo, digite seu nome
completo, pressione enter e digite a data atual;

5. Formate o texto como preferir;

6. Clique na ferramenta de texto e dentro do
primeiro retangulo e digite: Carta ao leitor.
Formate o texto como preferir;

7. Clique na ferramenta de texto, clique
dentro do segundo retangulo, agora clique com o
botdo direito dentro desta area, escolha a opcao
Fill with Placeholder Text;

8. Formate o texto como preferir;

9. Salve como fixacao5.

anotacoes
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Aula

mo InDesign temos a possibilidade de criar
listas, utilizando as caixas de texto. Antes
de criar uma lista, tenha em mente que serdo
considerados como tépicos da lista todos os
paragrafos contidos dentro da caixa de texto.
Para criar listas, o processo é muito simples.
Basta selecionar a caixa de texto e clicar sobre a
opcao de lista desejada, na barra de controle.
Lembrando que a caixa de texto deve ser
selecionada com a ferramenta de texto.

Para formatar listas, primeiramente
devemos transformar seus marcadores em texto.
Para converter listas de marcadores em texto,
basta acessar o menu Type>Bulleted &
Numbered Lists> Apply Bullets ou Apply
Numbers.

Ja para converter listas numeradas em texto,
o caminho é o menu Type>Bulleted & Numbered
Lists> Convert Numbering to text.

Conta Gotas

A ferramenta conta gotas, no InDesign,
serve para copiar todo tipo de formatacdo de um
objeto e aplicar em outro.

Para utilizd-la, primeiramente devemos
ativa-la utilizando o botao conta-gotas contido
na barra de ferramentas. Com a ferramenta
ativada, basta clicar sobre o objeto que contém a
formatacdo a ser copiada. Para aplicar a
formatacdo no outro objeto é necessario
seleciona-lo.

Quando for necessario “esvaziar’” o conta
gotas, basta clicar sobre uma drea em branco da
pagina.

Efeitos

Os efeitos sdo uma parte importante na hora
da criacao de capas e titulos que devem ser mais

destacados, porém, em textos comuns nao sdo
muito recomendados.

Selecionando uma caixa de texto com a seta
de selecao, podemos aplicar os efeitos.

Acesse os efeitos através do menu Window,
opcao Effects.

MNormal s | Opadty: [1000: >
| | Opacity

+ Object: Normal 100%

Stroke: Mormal 100%
Fill: Mormal 100%
Text:  Mormal 100%
[ ]1sclste Blending [ | Knockout Group
A 5

Clique no menu em destaque e, em seguida,
acesse Effects, uma lista de opcoes serd exibida.

Hide Options |

Effects > Tronsparency-
Cear Elfects Drep Shadorr. Al Ceel e
Cear All Transparsney Inner Shadow...
GobalLight.. e o
Inner Glow..
Bevel and Emboss...
Satin....
Easic Feather...
Directianal Feather.
Gradient Feather..

Transparency: permite definir um valor de O
a 100 onde O é totalmente transparente e 100,
normal. Podendo variar entre valores para dosar
o nivel de transparéncia.

Confira o exemplo abaixo:

Drop Shadow: permite definir uma sombra,
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indicando o angulo, a distancia, tamanho,
opacidade, entre outras opcoes.

Confira o exemplo abaixo:

Adobe InDesign, CS6

Inner Shadow: permite definir uma sombra
interna, indicando o dngulo, a distancia, tamanho,
opacidade, entre outras opcoes.

Confira o exemplo abaixo:

Inner Glow: permite definir um brilho
interno, indica valores para tamanho do brilho,
opacidade, esfumacado entre outros.

Confira o exemplo abaixo:

=

v

Bevel and Emboss: permite definir um efeito
estilo relevo (alto ou baixo).

Confira o exemplo abaixo:

InDesign

Satin: permite criar um efeito em relevo com
uma ideia de esfumacado.

Confira o exemplo abaixo:

Basic Feather: permite criar um efeito de
esfumacado.

Confira o exemplo abaixo:

Gradient Feather: permite criar um efeito
gradiente com esfumacado.

Confira o exemplo abaixo:

Dividindo o texto em Colunas

Uma parte muito importante na
diagramacao de paginas é a divisdo do texto.

Na barra de controle temos duas opcoes
relacionadas a divisdo do texto em colunas.
Lembrando que estas opgdes sé aparecerao caso
vocé selecione uma caixa de texto utilizando a
seta de selecao.

Veja a seguir as opcoes citadas:

mz: 11
4H ¢_4,233mz

1. Neste campo é necessario determinar em
quantas colunas sera dividido o texto contido
dentro da caixa selecionada.

2. Neste campo podemos definir o
espacamento entre as colunas de texto.
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6.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento;

2. Crie um retangulo no inicio da pagina de
um lado ao outro para receber o titulo;

3. Clique na ferramenta Texto e digite:
Mundo da leitura;

4. Crie um retangulo dentro da pagina de um
lado ao outro, até o final da pagina, nao é
necessario ficar encostado nas margens;

5. Com a ferramenta de texto, clique dentro
do retangulo maior. Novamente clique com o
botao direito dentro da area, selecione Fill with
Placeholder Text;

6. Clique no primeiro retangulo, pinte o
fundo de branco e aplique o efeito Drop Shadow
com distancia de Op4;

7. Selecione o titulo, formate como preferir e
centralize o titulo;

8. Divida o texto em duas colunas;

9. Aplique o efeito capitular no inicio do
texto;

10. Selecione o texto e aplique o
alinhamento Justificar;

11. Salve como Exercicio-aulaé.

6.2. Exercicios de Fixacao

1. Crie o modelo conforme o indicado, peca
ajuda ao seu instrutor para localizar aimagem.

anotacoes
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Aula

ma hora de redimensionar caixas de texto
utilizando a seta de selecao, devemos ter
alguns cuidados para se obter o resultado
desejado. Pois, pressionando algumas teclas ao
mesmo tempo em que redimensionamos a caixa,
oresultado podera ser diferente. Vejamos:

e Ao se redimensionar uma caixa de texto
sem pressionar nenhuma tecla, apenas a caixa de
texto sera redimensionada.

e Ao se redimensionar uma caixa de texto
pressionando a tecla CTRL, o texto sera
redimensionado juntamente com a caixa.

e Ao se redimensionar uma caixa de texto
pressionando a tecla SHIFT, apenas a caixa sera
redimensionada, mantendo as proporcoes entre
largura e altura.

e Ao se redimensionar uma caixa de texto
pressionando juntamente as teclas CTRL e
SHIFT, tanto o texto quanto a caixa serdo
redimensionados, mantendo as proporcoes de
alturaelargura.

Free Transform Tool

A Free Transform Tool é uma ferramenta que
além de redimensionar, permite girar qualquer
tipo de objeto.

Para ativa-la, basta clicar sobre seu icone na
barra de ferramentas principais.

Algumas dicas sobre a Free Transform Tool:
e Ela redimensiona qualquer tipo de objeto.

e Ao redimensionar uma caixa de texto, o
texto serd redimensionado juntamente sem
pressionar nenhuma tecla.

e Pressionando a tecla SHIFT as proporcoes
entre altura e largura serao mantidas.

e Para rotacionar objetos, vocé devera
manter o cursor do mouse um pouco afastado do
objeto até que a seta obtenha um formato
arqueado.

Temos algumas opcoes que se assemelham
ao que a Free Transform Tool faz na barra de
controle. Vejamos:

1. Neste campo podemos definir o dngulo de
rotacao do objeto.

2. Neste angulo podemos definir o angulo de
inclinacdo do objeto. Veja abaixo um exemplo:

Adobe InDesign CSé /Adobe inDesign C‘Sd/
0° 20°

3. Esta ferramenta rotaciona o objeto em
90° para adireita.

4. Esta ferramenta rotaciona o objeto em
90° para a esquerda.

5. Flip Horizontal: esta opcao inverte o
objeto horizontalmente.

6. Flip Vertical: esta opcao inverte o objeto
verticalmente.

7. Esta opcao mostra o objeto em relacao as
modificacoes, sendo assim possivel saber se o
objeto estd modificado ou estd em sua forma
original.
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7.1. Exercicios Passo a Passo

1. Abra o InDesign CSé;

2. Cliqgue no menu File, Open e abra o
exercicio de fixacdo criado na aula 6;

3. Selecione o titulo e através das
propriedades da barra de controle, incline o titulo
10° para a direita;

4. Atualize o documento, clique no menu File
e cligue na opcao Save.

7.2. Exercicios de Fixacao

1. Abra o InDesign CSé;

2. Para criar este exercicio siga o modelo
conforme o indicado. Peca ajuda ao seu instrutor
para localizar aimagem utilizada no exercicio.

anotagdes
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. ma cor gradiente nada mais é do que a
mistura de duas cores para formar uma

nova. No InDesign temos uma paleta destinada a
criacao de cores gradientes. Para exibi-la,
acessamos o menu Window e clicamos sobre a
opcao Gradient. Sera exibida a seguinte paleta:

1. Neste campo podemos prever como esta
ficando a cor gradiente.

2. Type: neste campo devemos definir o tipo
de gradiente que desejamos. Veja abaixo uma
relagao com os dois tipos de gradiente existentes
no InDesign:

_

3. Angle: esta opcao é ativada apenas no
modo linear e serve para definir a rotacio da cor
dentro do objeto.

4. Reverse: este botao troca as cores de
extremidade.

5. Ponto de predominancia: este ponto

define a predominancia de uma cor sobre a outra.

6. Esta é uma das cores do gradiente.

7. Esta é uma das cores do gradiente.

Algumas dicas sobre cores gradientes: para
adicionar uma nova cor no gradiente, basta
arrasta-la da paleta swatches até o ponto
desejado.

Uma cor gradiente pode ser formada por
mais de duas cores.

Para alterar as cores de posicao no
gradiente, vocé pode clicar sobre elas e arrasta-
las.

Paste in Place

No InDesign, temos duas principais maneiras
de se “colar” um objeto.

Talvez vocé ainda nao tenha percebido, mas
na maioria dos softwares que trabalham com
edicdo grafica, a opcao Colar ou CTRL+V colao
objeto no centro da tela.

Porém, temos a opcao Paste In Place, que
cola o objeto exatamente no mesmo lugar onde
ele foi copiado.

Para utilizar esta opcao, com o objeto ja
copiado, basta acessar o menu Edit e clicar sobre
aopcao Paste in Place. Também é possivel utilizar
o atalho ALT+SHIFT+CTRL+V.

Corner Options

A opcao Corner Options, no InDesign,
permite que adicionemos efeitos aos cantos do
objeto em questao.

Com o objeto ja selecionado, clicamos sobre
o menu Object e entdo clicamos sobre a opcao
Corner Options. Sera exibida a seguinte caixa de
didlogo:
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Corner Sze and Shape:

1. Effect: neste campo escolhemos o efeito
gue serd aplicado ao objeto. Veja abaixo uma
relacdo com todos os efeitos:

Inye ESE Rolinded

Rounde

[=

2. Size: neste campo devemos definir o
tamanho do efeito.

3. OK: aplica as alteracoes.
4. Cancel: cancela as alteracoes.

5. Preview: permite ver as alteracoes antes
mesmo de aplica-las.

8.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento;

2. Insira a imagem bgColorido e ajuste em
toda a pagina. Peca auxilio para seu instrutor;

3. Crie um retangulo conforme o indicado.
Para que os cantos tenham esse efeito, va até o
menu Object, Corner Options, defina o tamanho
"2p1" e o efeito "Fancy";

4. Com a ferramenta texto crie uma area na
pagina, fora do retangulo e digite: Adobe
InDesign;

5. Selecione o texto e altere o angulo para
90° ajuste dentro do retingulo e formate
conforme suas preferéncias;

6. Cligue no retangulo, acesse o menu
Window, Color, Gradient:

7. Altere o tipo para Linear;

8. Abra o Swatches, acesse o menu Window,
Color, Swatches;

9. Aplique as cores conforme suas
preferéncias;

10. Defina um valor para transparéncia do
retangulo;

11. Crie um retangulo e preencha com um
texto pronto do InDesign (Com a ferramenta
texto dentro da area, clique com o botao direito e
escolha Fill with Placeholder Text), formate
conforme o desejado;

12. Crie um Poligono e modifique os cantos,
va até o menu Object, Corner Options, defina o
tamanho "2p2" e o efeito "Inset". Digite CS6 e
formate conforme suas preferéncias;

13. Crie um Poligono e preencha com um
texto pronto do InDesign, formate conforme o
desejado;

14. Para ter uma ideia do resultado final,
confira aimagem conforme o indicado.

8.2. Exercicios de Fixacao

1. Faca a montagem conforme o indicado;

2. Serd necessario inserir uma imagem de
fundo chamada "Jornal", ajustar o seu tamanho e
reduzir a transparéncia para 50%;

3. Serd necessario inserir a imagem de
"Frasco" que serd usada dentro da pagina, ambas
estdo na pasta Arquivos auxiliares. Peca auxilio
ao seu instrutor.
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Adobe InDesign CS6
[ém de redimensionar os objetos utilizando
o mouse, o InDesign nos oferece uma
ferramenta que permite realizar esse processo.
Para acessar esta ferramenta, com o objeto ja
selecionado, devemos clicar sobre o menu
Object> Transform e optar pela opcao Scale. Sera
exibida a seguinte caixa de dialogo:

i = =

scilé X [100% 3 13 =
scile Y: 100% o5

Copy

[Clpreview g

|

1. Scale X: esta opcao se refere a largura do
objeto.

2. Scale Y: esta opcao se refere a altura do
objeto.

3. Constraint: esta opcdo mantém a
proporcao entre altura e largura do objeto,
guando ativada.

4. 0K: aplica as alteracoes.
5. Cancel: cancela as alteracoes.

6. Preview: quando ativada, esta opcao
permite visualizar as alteracoes antes de aplica-
las.

Step and Repeat

Caso vocé precise criar varias copias de um
mesmo objeto, com certeza a maneira mais facil
nao é o CTRL+C, CTRL+V. A ferramenta que vocé
deve utilizar é a Step And Repeat.

Com o objeto ja selecionado, para acessar

N,

esta ferramenta basta clicar sobre o menu Edit e
clicar sobre a opcao Step And Repeat. Sera
exibida a seguinte caixa de didlogo:

Step and Repeat
Repeat 4
1 Count: > 1 5 Gincdl
[Jcreate #s3 gnd 6 Orreview
Offset 2
3 verticat: = 1p0 Horzontak = 1p0

1. Repeat Count: neste campo vocé devera
informar o nimero de cépias desejadas.

2. Horizontal Offset: neste campo é definida
a distancia horizontal entre uma cépia e outra.

3. Vertical Offset: neste campo é definida a
distancia vertical entre uma cépia e outra.

4. OK: aplica as alteracoes.
5. Cancel: cancela as alteracoes.

6. Preview: quando ativada, esta opcao
permite visualizar as alteracoes antes de aplica-
las.

Alinhamento

Para que uma pagina fiqgue bem diagramada,
€ necessario que os objetos estejam bem
posicionados. Para Ihe auxiliar no
posicionamento dos objetos, vocé pode utilizar as
opcoes de alinhamento.

As seguintes opcoes sio exibidas na barra de
controle quando um ou mais objetos estado
selecionados.
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1. Align Left Edges: alinha todos os objetos
com o que estiver mais a esquerda na pagina.

2. Align Horizontal Centers: alinha os
objetos tomando como referéncia seus centros
horizontais.

3. Align Right Edges: alinha todos os objetos
com o que estiver mais a direita na pagina.

4. Align Top Edges: alinha todos os objetos
com o que estiver mais acima na pagina.

5. Align Vertical Centers: alinha os objetos
tomando como referéncia seus centros verticais.

6. Align Bottom Edges: alinha todos os
objetos com o que estiver mais abaixo na pagina.

7. Esta opcao permite escolher um ponto de
referéncia para o alinhamento. As opcdes mais
utilizadas sdo as duas seguintes:

e Align to Selection: alinha os objetos
selecionados.

e Align to page: alinha o objeto ou os objetos
selecionados na pagina. Por exemplo: com esta
opcao ativada e um objeto selecionado, para
centralizad-lo na pagina basta clicar sobre as
opcoes Align Horizontal Centers e Align Vertical
Centers.

Pathfinder

O InDesign possui uma ferramenta que
possibilita combinar dois objetos para formar um
novo. As opcoes desta ferramenta estdo contidas
em uma paleta que é conhecida como Pathfinder.

Para exibir a paleta pathfinder acessamos o
menu Window, posicionamos o mouse sobre a
opcao Object & Layout e entdo clicamos sobre a
opcao Pathfinder.

As opcoes relacionadas a combinacdo de
dois objetos para criar um novo, sao as seguintes:

Pathfindan

1@ 27 3 4@ 505

1. Add: combina os dois objetos para criar
um novo, mantendo a forma dos dois.

2. Subtract: subtrai o objeto que estiver na
camada mais acima do objeto que estiver na
camada mais abaixo.

3. Intersect: mantém apenas a area dos
objetos que esta se interceptando.

4. Exclude Overlap: exclui apenas a area dos
objetos que esta se interceptando.

5. Minus Back: Faz o contrario da opcao
Subtract. Subtrai o objeto que estiver na camada
mais abaixo do objeto que estiver na camada
mais acima.

9.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento;

2. Desenhe um retangulo em toda pagina e
escolhauma cor;

3. Insira a imagem da Aguia fora da pagina,
serd encontrada na pasta Arquivos auxiliares,
peca auxilio ao seu instrutor;

4. Arraste a imagem para dentro da pagina.
Selecione a imagem e acesse o menu Edit, Step
and Repeat, duplicaremos 5 vezes a imagem,
offset vertical de Opé6 e horizontal de 6p10;

5. Utilizando a ferramenta Scale, diminua
cada uma das cépias em 10% de seu tamanho;

6. Gire as imagens conforme o indicado;

7. Crie uma area de texto e digite "Aves de
Rapina", em mailsculo, posicione conforme o
indicado. Formate como preferir;

8. Crie outra area de texto que ocupe a
metade da pagina e digite como titulo "Tudo
sobre aves", em maiusculo. Logo abaixo, preencha
com o texto automatico do InDesign. Formate
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como preferir. Confira como deve ficar, conforme
oindicado;

9. Insira a imagem da aguia primeiramente
fora da pagina e, em seguida, mova para o lado do
texto. Qualquer duavida peca auxilio ao seu
instrutor;

10. Salve como Exercicio-aula9.

9.2. Exercicios de Fixacao

1. Faca a montagem conforme o indicado. As
imagens estao na pasta Arquivos auxiliares.
Qualquer duvida, chame seu instrutor.

anota§5es
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a uando o assunto s3o caixas de texto, uma
opcao que pode auxiliar o criador de
paginas é a Text Frame Options. Esta ferramenta
contém varias opcoes que podem ajudar na hora
de configurar uma caixa de texto. Para acessar
esta ferramenta devemos clicar sobre o menu
Obiject e clicar sobre a opcao Text Frame Options.
Sera exibida a seguinte caixa de didlogo:

Genersl | Basemna Optons | Aute-sie
Colurns: Fooed Number -

Mymber (1 1 Width; | =
Gutter: Zi1p0 Magirmur:
| Babnce Colomns
Inset Spaong
Jop: (7 Opd
Bottom: i 0p0

Left: |2
Right:

2 M

Vertical Justficaton
ghgn: Top - 4
Paragraph Spacng Lmé:x ~ Opl

I/ lgnore Taxt '.".I'|1|:|5

Frumwe

1. A opcao Number define o nimero de
colunas em que o texto sera dividido, e a opcdo
Width define a largura destas colunas.

2. Estas duas opcdes permitem inserir
espacamento acima e abaixo do texto.

3. Estas duas opcoes permitem inserir
espacamento a esquerda e a direita do texto.

4. Esta opcao permite alterar o alinhamento
vertical do texto dentro da caixa.

5. Esta opcao desativa a opcao Text Wrap.

6. A opcao preview permite visualizar as
alteracoes antes de aplica-las.

Transparéncia e Tint

Um novo usudrio de InDesign pode se
confundir entre duas ferramentas que sao um
tanto quanto parecidas: Opacity e Tint.

Porém, ha algumas diferencas que permitem
diferenciar uma ferramenta da outra.

A ferramenta Tint é encontrada na paleta
Swatches e sua funcao é clarear ou “enfraquecer”
uma cor.

A ferramenta Opacity, ou transparéncia, é
encontrada na barra de controle, e serve para
transparecer os objetos.

@pacity,

Text Wrap

A opcao Text Wrap serve para posicionar o
texto ao redor de objetos que o estejam
sobrepondo.

Para lidar com estas opcoes utilizamos a
paleta Text Wrap que pode ser ativada utilizando
o menu Window.

Lembrando que para aplicar o text wrap é o
objeto que estd sobrepondo o texto que deve ser
selecionado, e ndo o texto.

Veja, na préxima pagina, as principais
funcdes da paleta Text Wrap.
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Paleta Text Wrap

= 0p0 ra
T 8@,

¥

Wrap Options:
Wrap To: Bmmamhsms -
Contour Options:

-'.":h’.":

Inchude Inside Edges

1. No Text Wrap: esta opcao nao altera o
texto.

2. Wrap Around Bounding Box: esta opcao
faz com que o texto respeite uma margem em
forma de caixa ao redor do objeto.

3. Wrap Around Object Shape: esta opcao
posiciona o texto ao redor da forma do objeto.

4. Jump Object: esta opcao deixa um espaco
em branco apenas para o objeto.

5. Jump to next Column: esta opcao pula o
texto para a préoxima coluna, caso esta exista.

6. Estas opcbes permitem inserir
espacamento antes e depois do objeto.
7. Estas opcbes permitem inserir

espacamento a esquerda e a direita do objeto.

8. Aqui temos opcoes para desativar o text
Wrap em determinadas areas.

10.1. Exercicios Passo a Passo

1. Abra o InDesign CS6 e crie um novo
documento;

2. Insira uma imagem de fundo chamada

N,

"bgPet", acesse o menu "File/Place", e ajuste
conforme o indicado. A imagem estd na pasta
Arquivos auxiliares, chame seu instrutor para
auxiliar;

3. Crie trés retangulos com a mesma cor,
apenas altere a opacidade do segundo retangulo
para 45% e o terceiro para 35%. Veja o resultado
conforme o indicado;

4. Digite as palavras "Mundo, PET e
ESTRESSE", em cada retangulo, respeitando
maiulsculas. Veja o resultado conforme o
indicado;

5. Insira a imagem chamada "cao" fora da
pagina, e apligue uma sombra. Acesse o menu
"File/Place" para inserir e para aplicar a sombra
acesse o menu "Window/Effects/menu Effects e
Drop Shadow". A imagem esta na pasta Arquivos
auxiliares. Faca conforme o indicado;

6. Digite abaixo da imagem o titulo
"CAUSAS", formate como preferir e ainda aplique
uma sombra;

7. Crie uma area de texto que ocupe todo o
restante da pagina e insira um texto. Utilizando a
ferramenta Texto desenhe a area, para preencher
com um texto, clique com o botao direito dentro
do espaco e escolha Fill with Placeholder Text;

8. Com a ferramenta de Selecao clique no
texto e divida em duas colunas utilizando a barra
de controle;

9. Com a ferramenta de texto selecione todo
o texto e aplique o alinhamento justificado;

10. Selecione a primeira letra do texto,

acesse o menu Window/Type &
Tables/Paragraph. Defina trés linhas para
capitular;

11. Insira a imagem chamada "gato" fora da
pagina, em seguida ajuste entre as colunas, para
isso, acesse o menu "File/Place";

12. Para que o texto fique ao redor da
imagem, faca o seguinte: clique na imagem do
gato, acesse o menu Window/Text Wrap,
selecione a opcao "Wrap Around Bounding Box";
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13. Salvar como Exercicio-aula10.

10.2. Exercicios de Fixacao
1. Para realizar o exercicio, solicite o arquivo

auxiliar com o seu instrutor. Faca a montagem
conforme o indicado.

anotacoes
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. ma pagina mestre, ndo passa de um modelo
de pégina, onde podemos adicionar todos
0s componentes que desejamos que apareca em
todas as paginas do documento. Para trabalhar
com paginas mestre utilizamos a paleta Pages.

drage | M| s ) o)
ihor] 2['
(1] .

| Pagain 1 Spread e Al =

1. Um duplo clique sobre a palavra A-Master
ativa a pagina mestre.

2. Aqui temos os modelos de pagina que
podemos adicionar ao documento.

3. Neste campo temos as paginas que
compdem o documento. Para adicionar uma nova
pagina basta clicar e arrastar um modelo até este
campo.

Paleta Links

A paleta Links pode vir a ser muito util
guando trabalhamos com documentos de muitas
paginas.

Pois nela, podemos localizar imagens que
inserimos no documento. Isto ¢, ela fornece uma
lista com todas as imagens que fazem parte do
projeto e muitas informacdes sobre cada uma
delas.

Veja a seguir as principais informacoes que a
paleta Links fornece:

1

L . -, _ *
L Shond YO o
Link Enfo b

Mame: D5C000%.J0G ]
Foemat: IPEG
Page: 1 P
Calor Space: RGE
Seanese 0K
Sirws 21.5 KB (22409 bryte)
ICC Profile: Dotuman RGE
Aensal PRI T2
Effectiva PPI: T2
Dimasrgiosi: 120 « 140
Creatsrs R4GHI0 . RIC M40
Place Dare: mgurds-fe 10314 Z0T3
Layper: Liywr £
Medifind: ergaders. e 2008 2247
Pathe Ol .O0009609G
Craaviosn Date: tegs-fer. e 2008 2007 .
Trassparescy: o

1. Nestes campos podemos ver o nome da
imagem e sua extensao.

2. Nestes campos podemos ver em qual
pagina do documento estd aimagem.

3. Neste campo podemos visualizar em qual
Layer, no portugués Camada, estd aimagem.

Numeracao de Pagina

A insercao de numeracao de pagina é uma
tarefa um tanto quanto simples, pois se trata de
um caractere especial.

Para inserir a numeracido em uma pagina,
basta criar a caixa de texto que ird abriga-la,
posicionar o cursor de texto na posicdo desejada
e entdo acessar o menu Type> Insert Special
Caracter> Markers e clicar sobre a opcao
Current Page Number.

Caso vocé insira a numeracdo em uma

= Pagina mestre, ndo serda necessario atualiza-la
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nas outras, pois este processo ¢é feito
automaticamente.

Lembre-se que por ser um caractere
especial, vocé pode formatar a numeracio da
pagina como qualquer outro tipo de texto.

Exportando Projetos

Apesar de sua grande importancia, exportar
projetos é uma tarefa muito simples.

Com o projeto ja pronto, basta acessar o
menu File e clicar sobre a opcao Export. Na caixa
de didlogo que sera exibida deveremos escolher o
tipo de arquivo que desejamos.

 Adobe POF (interactive
| Adobe PDF (Frint)

EPS

EPUB

Fash CS6 Professional (FLA)
Flash Player (SWF)
HTML

InCopy Document
InDesign Mardwp (IDML)
InDesign Snippet

JPEG

PNG

XML

Lembrando que a opcdo mais indicada para
cartazes é a JPEG, e a mais indicada para
documentos que contém mais que uma pagina é a
PDF.

Porém, isto dependerd da grafica que ird
imprimir seus trabalhos, portanto sempre a
consulte antes de enviar seus trabalhos.

11.1. Exercicios Passo a Passo

1. Abra o Adobe InDesign CS6 e crie um
novo documento;

2. Clique na paleta Pages e dé um duplo
cligue sobre a palavra A-Master;

3. Clique na ferramenta de texto e crie uma
area de um lado ao outro da pagina, no rodapé;

4. Cligue no menu Type/lnsert Special
Caracter/Markers/Current Page Number,
aplique o alinhamento centralizado. Copie e cole
a area de texto na pagina ao lado. Confira o
resultado conforme aimagem indicada;

5.Dé umduplo clique na pagina 1;

6. Utilizando a ferramenta de texto digite
Noticias da hora, em mailscula, tamanho 48.
Confira o resultado conforme a imagem indicada;

7. Para inserir a imagem de capa, clique no
menu File, Place, abra a imagem1 e confira o
resultado conforme aimagem indicada;

8. Com a capa pronta, agora iremos inserir
uma nova pagina, clique na paleta Pages clique no
botao Create new page;

9. Com a ferramenta de texto digite 01, no
inicio da pagina, defina a fonte Arial, tamanho 60;

10. Crie um retangulo ao lado do nimero 01,
até o outro lado da pagina, altere a cor de
preenchimento para azul escuro;

11. Com a ferramenta de texto digite fora da
pagina "Esportes”, em mailscula, cor da letra
amarelo e, em seguida, arraste o titulo para
dentro do retangulo;

12. Insira a imagem esportes e ajuste
conforme o indicado. Acesse o menu File, Place e
abra aimagem2;

13. Com a ferramenta de texto abra um
espaco de um lado ao outro na pagina, clique
dentro da area com o botao direito e escolha a
opcao Fill with Placeholder Text;

14. Justifique o texto através da barra de
controle, e com a ferramenta de selecao ative a
ferramenta Balance Columns e divida em trés
colunas;

15. Para capitular a primeira letra do texto
cligue no menu Window/Type & Tables/
Paragraph. O capitular deve ocupar duas linhas.
Confira o resultado conforme a imagem indicada;

16. Precisaremos de um nova pagina, clique
na paleta Pages e clique no botao Create new

page;

17. Selecione o cabecalho da péagina ao lado,
copie e cole, altere a numeracao para "02" e o
titulo para "Saude", em maiusculo. Ajuste na nova

_~_pagina conforme a imagem indicada;
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18. Com a ferramenta texto abra um espaco
de um lado ao outro na pagina e um pouco para
baixo, clique dentro da drea com o botdo direito e
escolha a opcao Fill with Placeholder Text,
justifique o texto e divida em duas colunas;

19. Selecione a primeira letra e aplique o
recurso capitular, faca como no passo 14, no caso
aqui o capitular deve ocupar trés linhas;

20. Insira a ultima imagem representando a
pagina saude, para isso, acesse o menu File, Place
e abra a imagem3. Ajuste a imagem conforme o
indicado;

21.Salvar como revista.

11.2. Exercicios de Fixacao

1. Converter o nosso exercicio chamado
"Revista" no formato PDF, salvar na Area de
trabalho, fechar o InDesign e visualizar em PDF;

anotagdes
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mesta aula iremos apresentar algumas
novidades no Indesign CSé6. Content

Collector e Content Placer. O InDesign agora
apresenta duas novas ferramentas, o Content
Collector e o Content Placer, que podem ser
descritas como um copiar/colar avancado, pois
com eles vocé pode criar um link entre um objeto
original e as suas copias.

Para isso, é preciso usar o Content Collector
que, como o nome diz, coleta o contetdo do seu
layout. Basta selecionar a ferramenta e clicar em
qualquer elemento (frames de texto, vetor,
imagem) que esse elemento ird aparecer
automaticamente em um painel chamado
Conveyer.

O Conveyer pode ser considerado portanto
uma espécie de Clipping Board que permite
guardar em sua memoria mais de um elemento.
Por meio da ferramenta Content Placer, vocé
pode aplicar os elementos coletados no seu
layout. E ai estd o pulo do gato: ao aplicar um
elemento no layout, vocé pode linkad-lo ao
elemento original. Dessa forma, quando vocé
alterar o elemento original, todas as cdpias
ligadas a ele poderao ser atualizadas.

\ &8
*®

icone de link diretamente no frame

Para atualizar um frame com link, ndo é mais
necessario ir no painel Links, faca dois cliques
diretos no icone no canto superior esquerdo de
um frame com link para fazer a atualizacio.
Simples e pratico.

Alternate Layout

Dentro de um documento aberto do
InDesign, vocé podera visualizar diferentes
layouts. Isso permite conferir versoes diferentes
do seu documento para uso impresso, digital e
movel sem precisar abrir diferentes arquivos.
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Liquid Layout

Esse é, com certeza o recurso mais
interessante da nova versdao do InDesign. O
Liquid Layout permite dar regras a uma pagina do
seu documento, determinando como essa pagina
ira dispor seus elementos em layouts diferentes.
Portanto, uma pagina diagramada para uma tela
de iPad poderd se adaptar caso seja visualizada
em um tablet de tamanho e resolucao diferente.

Liquid Layout | =
Liguid Page Rule: Page: 80... 600 H:2 o}
| Object-based gl =)
'
Content: :
i
(] Auta-fit '%
| Object Constraints: — e ‘I'ﬂ' “““““ 5 Kol
Resize with Page: :
7 Height | width s
'
Pi !
z o o
Toy Left
_| Top o
| Bottom | Right
. .
Link options

As opcoes de linkagem de um objeto original
com sua copia estao muito mais complexas. Vocé
pode selecionar um objeto linkado e, no menu do
painel Links, em Link Options, vocé pode decidir
se ele seguira todas as alteracoes do objeto ao
qual ele esta linkado ou somente as mudancas de
tamanho, ou somente as mudancas de cor etc,
preservando assim as suas edicoes locais.

e “
" Update Link When Saving Document
[¥]wam f Link Update Wil Overwrite Local Edits

(& opeons

Preserve Local Edits whie Updating Object Links
[T} Interactivity [l others

[~ Frame Content

[} Appearance
[ sie and Shape

inDesign preserves edis made for the sslected srribuses,

[7I Rernove Forcad Line Breaks from Story
[7] pefine Custom Style Mapping | Settings...

| ok ] [ cancel |

Digital Publishing

H4 recursos exclusivamente criados para
otimizar a criacdo de publicacoes digitais.
Vejamos em detalhes:

e New Document Settings: Vocé ja pode
criar um arquivo especificamente voltado para
Digital Publishing. Para isso, crie um novo
documento e escolha Digital Publishing em
Intent.

e Preflight: O recurso Preflight agora
apresenta um preset especifico para Digital
Publishing.

e Package: Ao fazer um package do seu
arquivo, ele ndo somente salva na mesma pasta
as suas fontes e imagens utilizadas, mas também
pastas de arquivos HTML e outras pastas usadas
em Overlays (interatividades da Adobe Digital
Publishing Solution) de forma que o arquivo
mantenha essas interatividades funcionando
quando for reaberto posteriormente.

Vocé ainda pode encontrar mais novidades
no link a seguir:
http://helpx.adobe.com/br/indesign/using/whats-
new-csé.html
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12.1. Exercicios Passo a Passo

1. Abra o Adobe InDesign CS6 e crie um
novo documento com orientacdo do tipo
paisagem;

2. Digite Fotografia no inicio da pagina, em
maiuscula, tamanho 48;

3. Aplicando uma sombra no titulo. Clique no
menu Window/ Effects/ menu de controle/
Effects/ Drop Shadow;

4. Crie uma area de texto e preencha com
um texto do programa. Clique dentro da area
com o botao direito, selecione Fill with
Placeholder Text. Verifique o resultado conforme
aimagem indicada;

5. Divida o texto em duas colunas. Alinhe o
texto como justificado e com a seta de selecao
cligue no texto, na barra de controle clique em
Balance Columns, selecione duas colunas;

6. Capitulando a primeira letra. Selecione a
primeira letra do texto, acesse o menu Window/
Text Wrap, defina duas linhas. Veja o resultado
conforme o indicado;

7. Inserindo a primeira imagem. Acesse o
menu File/ Place, abra a imagem1 e ajuste
conforme o indicado;

8. Inserindo a segunda imagem que vai
ocupar o restante da pagina. Acesse o menu File/
Place, abra a imagem1 e ajuste conforme o
indicado;

9. Salve como Fotografia.

12.2. Exercicios de Fixacao

1. Converter o nosso exercicio chamado
"Fotografia" no formato PDF, salvar na Area de
trabalho, fechar o InDesign e visualizar em PDF;

anotagdes
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